
                    Cours de Formation Mysic 
 

Réalisé pour Mysic le  10 janvier 2007 par Daniel Touzeau  Page : 1/42 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cours de formation 

 

 Word 

 

Premier niveau 
 

 

Par Daniel Touzeau 



                    Cours de Formation Mysic 
 

Réalisé pour Mysic le  10 janvier 2007 par Daniel Touzeau  Page : 2/42 
 

Sommaire 
CHAPITRE 1 - PRESENTATION...................................................................................................... 4 

INTRODUCTION. ................................................................................................................................... 4 
OU TROUVE-T-ON WORD ? .................................................................................................................. 4 
VERSIONS DE WORD. ........................................................................................................................... 4 
POUR VOUS AIDER. .............................................................................................................................. 4 

Compagnon. .................................................................................................................................... 4 
Touche F1........................................................................................................................................ 4 
Menu contextuel. ............................................................................................................................. 5 

CHAPITRE 2 - POUR COMMENCER.............................................................................................. 6 

MON PREMIER DOCUMENT. ................................................................................................................. 6 
Ouverture de Word.......................................................................................................................... 6 
Composition de la fenêtre de travail de Word................................................................................. 8 

Zone des menus. .......................................................................................................................... 8 
Zone des barres d’icônes ou outils .............................................................................................. 8 
Zone d’aide.................................................................................................................................. 8 
Zone d’informations. ................................................................................................................... 9 
Zone des barres de défilement..................................................................................................... 9 
Zone d’affichage.......................................................................................................................... 9 
Zone de saisie. ............................................................................................................................. 9 

VOTRE PREMIERE SAISIE...................................................................................................................... 9 
Paragraphe................................................................................................................................... 9 
Mot. ........................................................................................................................................... 10 

MANIPULATION DES MOTS ET PARAGRAPHES. .................................................................................. 10 
Sélections....................................................................................................................................... 10 

Mot. ........................................................................................................................................... 10 
Ligne.......................................................................................................................................... 10 
Paragraphe................................................................................................................................. 11 
Sélection quelconque................................................................................................................. 11 

Copier/Couper – Coller................................................................................................................. 11 
Remarques................................................................................................................................. 11 

ENREGISTRER. ................................................................................................................................... 11 
IMPRIMER. ......................................................................................................................................... 12 

CHAPITRE 3 - REGLES, ALIGNEMENT, TITRE, LISTE ...... ...................................................13 

UTILISATION DE LA REGLE. ............................................................................................................... 13 
Les marges..................................................................................................................................... 13 
Les retraits..................................................................................................................................... 14 

Comment appliquer un format de paragraphe à plusieurs paragraphes ?.................................. 16 
LES TABULATIONS. ............................................................................................................................ 16 

Les différentes tabulations............................................................................................................. 17 
Tabulation de gauche................................................................................................................. 17 
Tabulation centrée. .................................................................................................................... 17 
Tabulation décimale. ................................................................................................................. 17 
Tabulation de droite................................................................................................................... 17 

Comment positionner une tabulation ? ......................................................................................... 17 
ALIGNEMENT DU TEXTE. ................................................................................................................... 18 
LES LISTES. ........................................................................................................................................ 18 

Comment faire ? ............................................................................................................................ 18 
LE FORMAT DE CARACTERE............................................................................................................... 19 

Police............................................................................................................................................. 19 
Taille de la police. ......................................................................................................................... 20 
Le style de la police. ...................................................................................................................... 20 



                    Cours de Formation Mysic 
 

Réalisé pour Mysic le  10 janvier 2007 par Daniel Touzeau  Page : 3/42 
 

La couleur de la police.................................................................................................................. 20 
Les autres attributs........................................................................................................................ 21 

LES TITRES......................................................................................................................................... 21 
Où est-ce que ça se trouve ? ...................................................................................................... 21 
Comment faire ? ........................................................................................................................ 21 
Vous restez sur votre faim ! ...................................................................................................... 21 

CHAPITRE 4 - LES TABLEAUX..................................................................................................... 23 

COMMENT EST CONSTRUIT UN TABLEAU. ......................................................................................... 23 
JE CREER MON PREMIER TABLEAU..................................................................................................... 23 

Autre méthode. .......................................................................................................................... 24 
Encore une autre méthode. ........................................................................................................ 24 

Résultat de la création................................................................................................................... 24 
LES SELECTIONS DANS UN TABLEAU. ................................................................................................ 25 

Sélection de tout le tableau. .......................................................................................................... 25 
Sélection d’une colonne................................................................................................................. 25 
Sélection d’une ligne. .................................................................................................................... 26 
Sélection d’une ou plusieurs cellules. ........................................................................................... 26 

ACTION SUR LES DIMENSIONS D’UN TABLEAU. ................................................................................. 26 
Taille globale du tableau............................................................................................................... 26 
Largeur d’une colonne. ................................................................................................................. 26 
Hauteur de ligne............................................................................................................................ 27 
Autres actions................................................................................................................................ 27 

BORDURE, TRAMES DE FOND. ............................................................................................................ 27 
Bordures. ....................................................................................................................................... 27 
Trames........................................................................................................................................... 28 

ET EN DEHORS DES TABLEAUX ! ....................................................................................................... 28 
ET POUR LES PAGES........................................................................................................................... 28 
L’ ORIENTATION DU TEXTE. ............................................................................................................... 29 
AJOUTER DES LIGNES ET DES COLONNES. ......................................................................................... 29 

Ajout d’une ligne. .......................................................................................................................... 29 
Insérer une colonne. ...................................................................................................................... 30 

PROPRIETES DU TABLEAU.................................................................................................................. 30 

CHAPITRE 5 - LES IMAGES........................................................................................................... 31 

INSERTION D’ IMAGES DANS UN DOCUMENT. ..................................................................................... 31 
Quelles images ? ........................................................................................................................... 31 
Images provenant d’un fichier. ..................................................................................................... 31 
Image provenant d’un copier coller. ............................................................................................. 33 
Image provenant de la bibliothèque. ............................................................................................. 33 
Insertion d’un dessin. .................................................................................................................... 34 

CHAPITRE 6 - STRUCTURATION DU DOCUMENT................................................................. 35 

POURQUOI UNE STRUCTURE ? ........................................................................................................... 35 
LES ENTETES ET PIED DE PAGES. ....................................................................................................... 35 

Qu’est-ce que l’entête et le pied de page....................................................................................... 35 
Les variables de champ. ................................................................................................................ 36 

Insérer les variables. .................................................................................................................. 36 
Où trouver les variables de champ?.............................................................................................. 37 

LE SOMMAIRE. ................................................................................................................................... 37 
Création d’un sommaire................................................................................................................ 38 
Mise à jour du sommaire............................................................................................................... 38 

LES SECTIONS. ................................................................................................................................... 39 

CONCLUSION PROVISOIRE.......................................................................................................... 42 

 



                    Cours de Formation Mysic 
 

Réalisé pour Mysic le  10 janvier 2007 par Daniel Touzeau  Page : 4/42 
 

Chapitre 1 - Présentation 

Introduction. 

Word est logiciel de traitement de texte conçu par Microsoft et universellement connu. Ce logiciel va 
vous permettre de faire tous les documents papier de correspondance entre vous et d’autres 
personnes. 

Word étant utilisé largement dans le secteur professionnel, il regorge de fonctions nombreuses que 
vous ne mettrez peut-être jamais en route. C’est pourquoi, cette formation vous donne un premier 
niveau qui vous permettra de réaliser une correspondance, ou un livre de bonne qualité. 

Les autres fonctions, plus complexes, seront abordées dans un autre niveau de formation. 

 

A noter que ce document est lui-même réalisé sous 
Word. 

 
Il existent d’autres logiciel de traitement de texte autres que Word comme OpenOffice (Gratuit). Si 
certaines fonctions de ces logiciels ont des menus différents, ils restent, neanmoins très proches de 
Word. 

Où trouve-t-on Word ? 

Word fait partie d’un ensemble de logiciels vendus par Microsoft qui peut se présenter sous plusieurs 
formes : 

• Pack Microsoft Office, 

• Works 
Sous ces dénominations commerciales, généralement intégrées dans une offre d’achat de matériel, 
vous retrouverez le logiciel Word. 

Versions de word. 

A chaque version de Windows, Microsoft annonçait en parallèle de nouvelles versions de word. 

Les dernières versions les plus répandues sont : 

• Word 2000 

• Word 2003 

• Word 2007 (la plus récente et commercialisée depuis peu). 
La cible de cette formation vise la version Word 2003, mais il y a peu de différences entres les 
différentes versions. 

Pour vous aider. 

Word vous propose plusieurs aides en ligne. 

Compagnon. 

Le compagnon de Word est un petit personnage qui vous propose au fur et à mesure de vos action 
une aide sur celle-ci. Pour activer le compagnon faire : ?>Afficher le compagnon Office. 

Touche F1. 

L’appui sur cette touche appelle une sous-fenêtre sur le coté droit de la fenêtre de Word qui vous 
propose une aide en ligne. 
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Menu contextuel. 

Si vous cliquez sur le bouton droit de la souris vous verrez apparaître un menu flottant appelé « menu 
contextuel ». En fait ce menu comporte les actions possibles par rapport au positionnement du 
curseur. Par exemple ce menu sera différent si vous être dans un paragraphe normal et si vous êtes 
dans un tableau ou sur image. 
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Chapitre 2 - Pour commencer 

Mon premier document. 

Ouverture de Word. 

Pour lancer l’exécution de Word, il y a plusieurs méthodes. 
1. L’icône de Word figure sur le bureau :  

Double-cliquez sur l’icône ou sélectionner l’icône par un clique puis appuyer sur la 
touche Entrée.  
 

2. L’icône figure dans la barre de lancement rapide.   
Cliquez une fois sur l’icône. 

 

3. Vous utilisez le menu « Démarrer ».  
 

 

 
 

 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

4. Lancement à partir d’un fichier Word : Choisir le fichier à ouvrir dans l’explorer (fichier avec 
l’extension .doc), puis double 
cliquez sur le fichier. Word 
s’ouvre alors avec le 
document sélectionné, 
ouvert dans la fenêtre 
d’exécution. 

  
  
  
  
  
  

5. Lancement à partir 
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des documents récents : 

 

cliquez sur Démarrer et choisir le menu  qui affiche les 
documents que vous avez ouverts récemment. Choisir le document Word et cliquez une fois 
pour l’ouvrir. 
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Composition de la fenêtre de travail de Word. 

Après le lancement de Word, vous devriez voir s’afficher la fenêtre suivante : 

 

 
La fenêtre comporte un certain nombre de zones ayant chacune un rôle : 

Zone des menus. 
Cette zone contient tous les menus permettant d’accéder à toutes les fonctions de Word. 

Zone des barres d’ icônes ou outils 
Ont peut positionner une ou plusieurs barres d’outils, soit dans le haut de la fenêtre, soit sur le bas, 
mais aussi à gauche et à droite. 

Nous verrons plus loin dans le chapitre « personnalisation » comment positionner ces barres d’outils. 

Chaque barre d’outils comporte des icônes qui pour chacune d’elle effectuent une tâche prédéfinie. 

Les principales tâches seront vues au fur et à mesure. 

Zone d’aide. 
Cette zone fournie en fonction de la tâche à accomplir, une aide ou un choix sur des valeurs. Cette 
zone n’est pas systématiquement présente. 
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Zone d’ informations. 
Cette zone situé dans le bas du cadre de la fenêtre affiche en temps réel des informations sur la page 
en cours, la section, la ligne dans la page, la colonne dans la ligne et l’utilisation de certaines 
fonctions. 

Zone des barres de défilement. 
Vous avez deux barres permettant de faire défiler les pages dans le sens vertical ou horizontal. Au bas 

de la barre de défilement vertical se trouvent deux boutons  permettant un défilement page à 
page. 

Zone d’affichage. 
Cette zone permet de changer de mode d’affichage. 

Zone de saisie. 
C’est la zone bien sur la plus intéressante et que nous allons développer tout au long de ce cours. 

C’est dans cette zone que le texte sera saisi en utilisant principalement le clavier. 

Dans cette zone apparaît le document en cours de saisie. Au lancement de Word, un document vierge 
est automatiquement ouvert en création.  

Votre première saisie. 

Sans toucher aux menus ou à une icône de la barre d’actions, commencer à saisir un texte si possible 
sur au moins deux lignes. (En fin de ligne n’utilisez pas la touche « Entrée »). 

J’attends ….. . 
Voici ce le genre de texte que vous devriez avoir : 

 

 
Vous pouvez voir qu’à chaque frappe d’un caractère, l’indice colonne augmente, qu’à chaque ligne 
nouvelle le nombre de lignes augmente et que la distance entre le bord du papier et 
le caractère venant d’être frappé augmente. 

Maintenant, à la fin de votre saisie, appuyez sur la touche « entrée » . De fait vous 
venez de créer un nouveau paragraphe. 

Paragraphe. 

Un paragraphe est constitué de tous les mots saisis entre 
deux touches « entrée ». 

 

3cm 
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Refaite une nouvelle saisie et terminez par une touche « entrée ».  

Allez ensuite dans la barre d’action et cliquez sur l’icône . Cette icône permet d’afficher dans le 
document les caractères spéciaux. Vous devez voir votre document sous une forme analogue. 

 
Vous pouvez voir que chaque fin de paragraphe est « marqué » par un caractère spécial. Remarquez 
également que chaque « espace » frappé est représenté par un point dans ce mode d’affichage. 

Cliquez de nouveau sur pour revenir à l’état précédent. 

Mot. 

Un mot est une suite de caractères séparés par au moins 
un blanc. 

 

Manipulation des mots et paragraphes. 

Les mots et paragraphes sont les principales notions de Word. Nous ajouterons plus tard les notions 
de titres et de sections. 

Word offre des facilités pour manipuler ces notions. 

Sélections. 

Mot. 
Pour sélectionner un mot, cliquez deux fois sur un des caractères du mot. Le mot est alors 
entièrement sélectionné (y compris l’espace de droite du mot, sauf s’il y a un point coller après le 
mot). 

Ligne. 
Pour sélectionner une ligne, mettre votre curseur dans la marge de droite, face à la ligne à 
sélectionner et cliquez une fois. La ligne entière est sélectionnée. 
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Paragraphe. 
Pour sélectionner un paragraphe, mettre le curseur dans la marge de droite, face au paragraphe à 
sélectionner et cliquez deux fois. Le paragraphe entier est sélectionné. 
 

Sélection quelconque. 
Il est possible de sélectionner tout ou partie du document. 

Pour sélectionner tout le document, faire le menu : Edition > Sélectionner tout ou la 
combinaison des touches Ctrl+A. 

Pour sélectionner une partie, positionnez le curseur avec la souris sur un caractère, puis en 
maintenant le doigt sur le bouton gauche de la souris, déplacez vous jusqu’au point qui est la fin de 
votre sélection. Vous devez voir la sélection en fond noir augmenter. 

 
Une autre solution consiste à positionner le curseur sur le début, puis relâchez le bouton de la souris, 
allez sur la fin de la sélection et cliquez avec le bouton gauche de la souris tout en 
maintenant la touche majuscule. 
  

Une autre solution, valable lorsque vous devez parcourir plusieurs pages à sélectionner : 

Positionnez le curseur sur le début, appuyez sur la touche F8  puis relâchez le bouton de la 
souris, allez sur la fin de la sélection et cliquez avec le bouton gauche de la souris. 

Copier/Couper – Coller. 

A partir d’une sélection, vous pouvez alors copier le contenu de votre sélection, puis en déplaçant 
votre curseur avec la souris, coller ce que vous venez de copier. 

Vous pouvez répéter ce collage autant de fois que vous le souhaité, ce que vous avez sélectionné 
reste dans ce l’on appelle le « presse papier » tant qu’une autre sélection n’a pas été faite. 

Remarques. 

Vous verrez plus loin qu’un document Word peut 
comporter des images, des objets Microsoft (tableau 

Excel par exemple), etc.… Une sélection peut 
« englober » aussi tous ces éléments. 

Enregistrer. 

Il est impératif de comprendre que pour qu’un document soit conservé, il faut l’enregistrer sur disque. 
Tant que vous n’avez pas enregistré un document, celui-ci n’existe que dans la mémoire de votre PC. 
Si vous avez une panne de courant, toute votre saisie sera perdue, de même si vous fermer 
accidentellement la fenêtre Word. 

Pour enregistrer votre document appelez le menu : Fichier > Enregistrer (ou CTRL + S). Dans la 
fenêtre qui s’affiche, donnez un nom et sélectionnez un dossier pour ranger votre document. 
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Régulièrement, au cours de la frappe de votre document, n’hésitez pas à faire (CTRL+S) pour 
enregistrer votre travail. (Après un premier enregistrement, la fenêtre d’enregistrement ne s’affiche 
plus). 

Si vous voulez enregistrer votre document dans un autre dossier, utilisez le menu :  
Fichier > Enregistrez sous… 

Imprimer. 

Votre document achevé, vous voudrez certainement le voir sur du papier. Pour l’imprimer, faire le 
menu : 
Fichier > Imprimer (ou CTRL+P) 
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Chapitre 3 - Règles, Alignement, Titre, Liste 

Utilisation de la règle. 

Word copie les fonctions d’une machine à écrire. Or, sur une machine à écrire classique, il existe ce 
que l’on appelle la règle qui permet de poser les marges de droite et de gauche et les tabulations. 

Sous Word on retrouve cette même analogie. 

Les marges. 

Les marges bornent l’espace où l’on peut écrire du texte. Il y a donc une marge de gauche et une 
marge de droite et également une marge de haut de page et de bas de page. Ces marges sont définie 
au niveau du document (ou d’une section). 

  

 
 

Quand vous avez ouvert ce nouveau document 
des marges standards ont été définies. Il est 
possible de les modifier, de même qu’il est 
possible de modifier l’orientation de la page. 

Pour modifier les marges, faites 

Fichier>Mise en page… 
 
Il existe des onglets 
supplémentaires qui 
permettent de choisir le 
format du papier (A4 en 
standard) et la disposition 
des pages l’une par rapport 
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à l’autre, comme dans le cas d’un livre. Nous détaillerons 
ces onglets dans le Word Avancé. 
Une autre solution consiste à survoler avec la souris la 
limite des marges (passage de la couleur grise avec la 
couleur blanche). Une double flèche apparaît. Vous 
pourrez alors glisser la marge dans un sens ou dans 
l’autre. 

 
 

Les retraits. 

Par rapport à ces marges, on peut agir en effectuant un retrait du texte par rapport aux marges soit 
vers la droite, soit vers la gauche. 

 

Pour voir l’incidence des marges sur le texte (en fait sur le ou les paragraphes), avec votre souris : 
• Cliquez sur un des paragraphes saisis pour positionner le 

curseur, 

• allez sur le curseur de retrait de marge droite, cliquez et en 
maintenant votre doigt sur le bouton droit de la souris déplacez 
le curseur vers la gauche et relâchez le quelque part,  

• Observez ce qui se passe sur le texte.  

 
Vous observez que tout le texte du paragraphe se trouve automatiquement tasser vers la gauche. 

Nous allons faire la même chose sur le curseur de retrait de gauche, mais observez que celui-ci est 
différent.  
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Faite la même opération de glissement que précédemment mais vers la droite. 

 

 
Nous allons maintenant faire glisser le retrait de première ligne, soit vers la gauche, soit vers la droite. 

Remarquez que lorsque vous cliquez sur un curseur, il apparaît une ligne pointillée qui permet de voir 
avec quoi on s’aligne (la ligne pointillée noire sur la figure suivante). 

 

 
 

Nous pouvons également modifier dans une boite de dialogue tous ces éléments. Pour faire apparaître 
cette boite, il suffit de faire un double-clique sur l’un des curseurs ou faire le menu : 

Format>Paragraphe… 

 
Notez que dans le cas où il 
existe un retrait de première 
ligne, le retrait de gauche se 
calcule à partir de la valeur 
du retrait de première ligne : 

Retrait total = retrait de 
gauche + retrait positif ou 
négatif. 
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Cas d’un retrait positif 

 

 
 

Comment appliquer un format de paragraphe à plusieurs 
paragraphes ? 
Dans notre exemple nous avons d’abord saisi deux paragraphes, puis nous sommes revenus sur le 
formatage du premier paragraphe. Si nous avions voulu donner au deuxième paragraphe le même 
format, il nous aurait suffit dans chaque manipulation de sélectionner le ou les paragraphes 
auxquels nous voulons appliquer ce format. (Rappelez-vous CTRL+A pour tout le document) 

Mais cela n’est pas très pratique.  

Alors, si nous donnons le format dès le premier paragraphe, au fur et à mesure de la saisie, les 
autres paragraphes prendront le format du paragraphe précédent. 

Mais cela n’est toujours pas très pratique car à chaque nouveau document je serai obligé de 

réinstaller le formatage du paragraphe.  
Heureusement, nous verrons plus loin qu’avec la notion de modèle nous résoudrons non seulement 

le problème de formatage de paragraphe, mais bien d’autres choses. Alors patience.  
En attendant, un petit truc. Pour copier un format, positionnez le curseur dans le paragraphe dont 

vous voulez copier le format, puis cliquez sur l’icône de copie de format   , ensuite amenez le 
nouveau pointeur obtenu (qui ressemble à une balayette) dans le paragraphe à transformer. Un clique 

et ça marche …  

Les tabulations. 

Autant vous dire tout de suite, moins on s’en sert mieux on se porte.  
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Cependant dans certains cas, les tabulations peuvent rendre service. 

Si vous souhaiter positionner à un même endroit d’une page des textes ou des chiffres, les tabulations 
peuvent vous y aider. 

Voyons tout de suite un exemple : 

 

 
 

Les différentes tabulations. 

Tabulation de gauche. 
Cette tabulation permet de cadrer un texte de la gauche vers la droite, à partir de la position de la 
tabulation. 

Tabulation centrée. 
Le texte sera centré autour de la position de la tabulation. 

Tabulation décimale. 
Cette tabulation est surtout utilisée pour des nombres, elle permet de cadrer les nombres sur la 
position de la virgule (réelle ou virtuelle). 

Tabulation de droite. 
Le texte sera cadré sur le dernier caractère de droite. 

Comment positionner une tabulation ? 

Positionnez votre curseur souris sur la position de la règle où vous souhaiter créer une tabulation et 
cliquez une fois. Une tabulation de gauche apparaît. 

Si vous voulez créer un autre type de tabulation, alors 
cliquez deux fois sur la règle et une fenêtre apparaît. 

Dans cette fenêtre vous avez le choix sur le type de 
tabulation. 

Vous pouvez également supprimer une ou toutes les 
tabulations. 

Vous pouvez également définir ce que l’on appelle des 
points de suite, ce qui veut dire que les blancs entre les 
tabulations seront remplacés par soit par des points, des 
tirets ou des soulignés. 
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Voici ce que donne notre exemple avec des points de suite. 
 

01 .........Roses 

A noter que la copie de format,  copie aussi les tabulations. 

Alignement du texte. 

En standard, le texte est cadré sur la gauche.  
Cependant, pour un courrier soigné, il est souvent plus présentable de réaliser un texte justifié. C’est 
le cas du texte de ce document. 

Dans quelques cas de figure (les titres, les commentaires, …) il est important d’avoir un texte centré 
comme : 

Titre 

Enfin, plus rarement un texte cadré à droite fera de l’effet. 

 

Le format d’alignement du texte se manipule par les icônes :  

 
Vous pouvez également accéder à l’alignement du texte qui s’applique à 
un ou plusieurs paragraphes par Format>Paragraphe… 

Dans la fenêtre, choisir l’alignement désiré. 

 

 
 

Les listes. 

Dans un texte, lorsque l’on a à citer plusieurs éléments, il est souvent commode de créer alors une 
liste, numéroté ou non des différents éléments. (Une liste non numéroté s’appelle une liste à puce (la 
puce étant le petit caractère qui précède le texte)). 

Voici quelques exemples : 

1) Elément 1, 

2) Elément 2, 

3) Elément 3. 
 

• Valeur 1, 

• Valeur 2, 

• Valeur 3. 

Comment faire ? 

Prenons tout de suite de bonne habitude. Pour réaliser les exemples ci-dessus, nous n’avons pas 
besoin de tabulations. 

Liste numérotée 

Liste à puce 
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Une liste est généralement décalée vers la droite de façon à apparaître de manière plus évidente. 

D’ailleurs, si vous avez des listes imbriquée, il est préférable d’imbriquer chaque  sous liste dans la 
liste. Exemple : 

1) MA LISTE 01 

a. Ma sous liste 01, 

b. Ma sous liste 02, 

i. Ma sous sous liste 01, 
ii. Ma sous sous liste 02, 

c. Ma sous liste 03,  

i. Ma sous sous liste 01, 

ii. Ma sous sous liste 02 

d. Ma sous liste 04,  

2) MA LISTE 02, 
a. …. 

b. …. 

i. …. 

ii. …. 

c. ….. 

d. …… 
3) ….. 

 

Pour constituer cette liste, il suffit : 

1) Sur la ligne vierge, provoquez un retrait par l’icône :  (avec 
Windows 2003 il est possible d’utiliser la touche tabulation). 

2) Ensuite, choisissez le type de liste (numéroté ou à puce) par 

l’icône :  

3) Puis tapez votre texte sans provoquer de retour à ligne au milieu de votre texte. En effet, le 
Retour Ligne provoque un nouveau paragraphe et donc une nouvelle ligne numéroté ou à 
puce. 

4) Pour créer un nouveau retrait utilisez de nouveau :  

5) Etc.… 

6) Pour revenir sur une liste de niveau supérieur, utiliser le retrait négatif :  
7) Etc. … 

Le format de caractère. 

Jusqu’à présent, nous ne nous sommes pas préoccupé du format des caractères. Nous avons pris le 
standard (généralement Police=Time New Roman, Taille=12 points). 

Police. 

La police caractérise le caractère utilisé.  

Par exemple voici le même texte dans différentes polices : 

Exemple de texte Police 

La police caractérise le caractère utilisé Tahoma 

La police caractérise le caractère utilisé Calligraphic 

La police caractérise le caractère utilisé Balloon 

La police caractérise le caractère utilisé Time New Roman 

Il existe des centaines de polices différentes. A vous de choisir … 
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Taille de la police. 

Voici quelques exemples de texte avec des tailles différentes. 

Exemple de texte Taille de la Police 

La police caractérise le caractère utilisé 10 

La police caractérise le caractère utilisé 12 

La police caractérise le caractère 
utilisé 

14 

La police caractérise le 
caractère utilisé 

16 

La police caractérise 
le caractère utilisé 

22 

La police 
caractérise le 
caractère 
utilisé 

36 

 

Le style de la police. 

Une police peut être éditée en gras et italique ou les deux gras et italique. 
Le changement de style peut se faire par les 

icônes : . Egalement en cours de frappe 
vous pouvez passer en gras par la combinaison 
CTRL+G et CTRL+I pour l’italique. Refaire ces 
combinaisons pour revenir au texte normal. 

La couleur de la police. 

Vous pouvez également utilisez la couleur pour 
teinter vos caractères (n’en n’abusez pas car c’est 
très fatiguant à lire !!!). 

Cela se fait par l’icône :  
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Les autres attributs. 

Il existe d’autres attributs qui sont accessibles par le menu Format>Police. On retrouve aussi dans 
cette fenêtre tous les éléments relatifs aux polices. 

Les titres. 

Si vous analysez ce document de formation, vous rentrerez de nombreux titres. Par exemple « Les 
titres », est un titre (étonnant non !!!). 

Alors comment faire un titre ? 

Pour vous faciliter la création de titre, Microsoft a prévu lorsque vous ouvrez un nouveau document, 
de vous « offrir » 3 styles de titre. 

Où est-ce que ça se trouve ? 
Les titres tout « préparés » se trouvent dans la liste déroulante : 

 
Il y a 3 niveaux de titres appelés Titre 1, Titre 2, Titre 3. 

Comment faire ? 
Pour utiliser ces titres. 

Terminez votre paragraphe par la touche « Entrée ». 

Sur la nouvelle ligne vierge, chercher dans la liste le titre qui vous convient et cliquez dessus. 

Ensuite il suffit de taper votre texte de titre. 
Finaliser votre titre par la touche « entrée » (fin de paragraphe). 

Vous pouvez saisir votre texte sur la ligne créée. 

Vous restez sur votre faim ! 
En effet, si vous souhaitez des titres ayant, par exemple, une police différente de celle proposée, en 
dehors de l’action : 

1. Sélection du titre, 
2. Choix d’une nouvelle police,  

3. nouvelle taille de police. 

Et ceci vous devrez le faire pour chaque titre saisi.  

 

Si j’en parle ainsi c’est qu’il y a une solution ?  



                    Cours de Formation Mysic 
 

Réalisé pour Mysic le  10 janvier 2007 par Daniel Touzeau  Page : 22/42 
 

 

Hé oui ! Mais c’est encore trop tôt, nous verrons ça avec la notion de modèle …  
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Chapitre 4 - Les tableaux 

Les tableaux sont importants car ils permettent de structurer de l’information à présenter à des 
personnes. 

Si vous êtes allés sur Internet, vous avez certainement rencontré de nombreuses fois des tableaux. 
Pour vous en convaincre il suffit d’aller sur le site de Mysic sur une des pages de présentation des 
cours de formation : 

http://www.mysic-assoc.net/spip/MYSIC_index_01.php3?chapitres=20.01&id_rubrique=6 

 
Word vous permet de créer des tableaux complexes. 

Nous allons commencer par un tableau simple. 

Comment est construit un tableau. 

Un tableau est composé d’un certain nombre de colonnes (dans l’exemple ci-dessus il y a 7 colonnes), 
et d’un certain nombre de lignes. 
Rassurez-vous, il est possible à tout moment d’ajouter ou de supprimer des colonnes et des lignes. 

Au croisement d’une colonne et ligne on trouve une cellule. 
(Ces notions sont identiques dans Excel). 

Je créer mon premier tableau. 

Pour créer un tableau, Word vous propose une icône :  

Lorsque vous appuyez sur cette icône, il faut maintenir la touche gauche enfoncée. Vous avez alors la 
possibilité de définir en glissant votre souris vers la droite ou vers le bas de définir le nombre de 
colonnes et de lignes. 
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Autre méthode. 
Passez par le menu Tableau>Inséré…>Tableau. 

 

Encore une autre méthode. 
Nous n’allons pas détailler cette méthode qui est intuitive. On y accède par : 

Tableau>Dessiner un tableau. Icône = . Cette icône n’est proposée en standard. 

Résultat de la création. 

   

   

 
Voici le résultat que vous devez obtenir (3 colonnes et 2 lignes). 

Pour remplir ce tableau, il suffit de mettre le curseur dans une cellule et taper votre texte. 

 

Voici mon premier texte dans 
un tableau 

  

   

   

 
Si vous cliquez dans une cellule, observez ce qui se passe au niveau de la règle : 

 
En fait, pour chaque cellule vous disposez des possibilités vues plus avant sur les retraits et également 
les retraits de première ligne. 
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Pour chaque cellule vous pouvez définir le formatage du texte (cadrage, police, taille, couleur, 
tabulations). 

Nous verrons également, que pour chaque cellule on pourra définir une couleur de fond et le type de 
bordure de la cellule et l’orientation de texte. 

Il faut voir chaque cellule comme une mini-page dans laquelle vous pouvez taper plusieurs 
paragraphes ou des listes. 

Lorsque l’on travail avec un tableau, il est intéressant de pouvoir donner à une ou plusieurs colonnes 
ou à une ou plusieurs lignes, ou à une ou plusieurs cellules le même format. Pour faire cela, il faut 
savoir comment sélectionner dans un tableau. 

Les sélections dans un tableau. 

Sélection de tout le tableau. 

Lorsque vous survolez un tableau avec la souris, vous verrez apparaître dans le coin haut gauche du 
tableau un petit carré avec une croix à l’intérieur. Si vous cliquez sur cet objet, tout le tableau sera 
sélectionné. 

 

 
 

 

 

 

 

Une fois la sélection opérée, toutes les actions sont possibles comme copier-coller, couper-coller ou 
supprimer, ou un changement de formatage ou d’autres actions spécifiques aux tableaux. 

Sélection d’une colonne. 

Si vous amenez votre souris sur le bord haut d’une colonne, vous verrez apparaître une petite flèche. 
Ensuite, en cliquant, toute la colonne sera sélectionnée (aussi longue soit-elle). Cette sélection 
apparaît en noir. 

 

 
Pour sélectionner plusieurs colonnes, déplacez votre souris soit vers la droite, soit vers la gauche en 
maintenant le click de gauche enfoncé et vous verrez les colonnes sélectionnées au fur et à mesure. 
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Sélection d’une ligne. 

La sélection d’une ligne se fait comme pour un paragraphe. Il suffit de mettre votre curseur en marge 
gauche (le curseur devient alors un flèche). Cliquez sur bouton droit de la souris et maintenez en 
descendant (ou en montant) de ligne en ligne. 

Sélection d’une ou plusieurs cellules. 

Cliquez dans une cellule puis avec le bouton gauche de la souris et en le maintenant enfoncé, 
déplacez vous. Vous verrez les cellules sélectionnées au fur et à mesure du déplacement de la souris. 

 

Action sur les dimensions d’un tableau. 

Taille globale du tableau. 

 
Le petit carré situé au bas et à droite du tableau vous permet de modifier la taille global de celui-ci. 

Largeur d’une colonne. 

 
Si vous déplacez le curseur sur une frontière de colonne, vous verrez apparaître un changement du 
curseur qui vous invite en appuyant sur bouton gauche de la souris à changer la largeur des colonnes. 

Vous avez également cette même possibilité en passant le curseur sur la règle sur la limite de deux 
colonnes. Une flèche double apparaît. 
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Hauteur de ligne. 

 
De la même façon que pour les colonnes, la hauteur des lignes est accessible, soit par le curseur situé 
sur une ligne, soit avec le curseur dans la règle de gauche. 

Autres actions. 

Il existe une autre voie qui change les propriétés du tableau dont la largeur colonne et ligne. Nous 
verrons cette action plus loin. 

Bordure, trames de fond. 

Lorsque vous créez un tableau celui-ci est définit avec une bordure standard entourant chaque cellule. 

Bordures. 

Vous pouvez agir sur les bordures des cellules par le menu : Format>Bordure et Trame (ou par le 
menu contextuel identique). 

 

Attention !!! 
La modification jouera sur les cellules sélectionnées. 

Généralement ont sélectionne tous le tableau.  
 
Le type de bordure « Aucun » permet 
d’utiliser un tableau en lieu et place de 
tabulations (en plus souple). Dans ce 
mode, les bordures sont invisible à 
l’édition mais apparaissent sous forme 
de lignes fines et grise en mode saisie. 

Le type « Encadré » créer un cadre 
périphérique à la sélection et sans 
quadrillage à l’intérieur. Le mode 
« Quadrillage » créer des lignes et 
colonnes de largeur = à Largeur. 

 

Le style permet de choisir des lignes 
continues ou pointillées de différents 
styles. 

 

Dans le mode « Apercu » vous créez 
vos lignes colonne de façon intuitive. 
Essayez, c’est l’adopter. 

Enfin si vous avez oublié de 
sélectionner le tableau, vous pouvez 
vous rattraper avec « Appliquer à ». 
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Trames. 

Avec les trames, vous 
choissez une couleur de fond 
avec ou non un style que 
vous pouvez appliquez (si 
vous n’avez pas fait de 
sélection) à un tableau, 
cellule ou paragraphe. 

 

 

 
 

 

 

 

 

 
 

 

 

 

 

ET en dehors des tableaux ! 

Vous pouvez, maintenant que vous connaissez la boîte de dialogue, utilisez les bordures et les trames 
pour des paragraphes simples et hors tableau. Voici quelques exemples. 

 

Exemple 1 

 

Exemple2 

ET pour les pages. 

Eh bien, pour les pages, ont peut aussi réaliser des bordures. Ces bordures s’appliqueront à tout le 
document ou à une section.  

 

Mais l’on pas encore vu les 

sections !!!!!!!  
 

Alors patience (sauf pour ceux qui 
savent). 
 

Pour tous le document, voici la boîte de 
dialogue :  

Chaque page sera entourée par des 
palmiers (sympa non !) 
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L’orientation du texte. 

Pour les titres des colonnes, on est souvent amenez à se rendre compte que le texte du titre en 
horizontal n’attire pas l’œil. 
Vous pouvez changer l’orientation du texte d’une cellule dans le tableau. 

Pour ce faire, nous allons appeler la boîte bordure et trame et dans cette boîte choisir le bouton 
« Afficher la barre d’outil ». 

Vous devez avoir ceci qui s’affiche à l’écran.  
Cette boîte regroupe toutes les options sous une 
forme condensée. Vous pouvez voir également à 
droite de la deuxième ligne de cette boîte 
l’orientation du texte. Il y a aussi les possibilités 
de cadrage dans les cellules, la répartition des 
hauteurs de lignes ou des largeurs de colonne. Enfin des possibilités de trier les lignes en mode 
ascendant ou descendant et de faire des totaux de valeurs numériques d’une colonne ou d’une ligne. 

Voici un exemple de ce que l’on peut faire : 
 

D
a
te
 

Li
b
e
llé
 

d
u
 

co
u
rs
 

O
ù
 

1/1/2007 Word Paul Bert 

1/2/2007 Excel Jules Verne 

 

Joli Non !  

Ajouter des lignes et des colonnes. 

Ajout d’une ligne. 

Pour ajouter une ligne, le plus facile est de se mettre dans la case le plus à droite et en bas du 
tableau et de provoquer une tabulation. Cela créer une ligne supplémentaire. 

Mais dans certaines situations  vous souhaiterez ajouter une ligne en plein milieu du tableau. Pour 
faire cela, positionnez vous sur la ligne du tableau puis appelez le menu :  

 
Choisir alors d’insérer une ligne au-dessus de la 
ligne actuelle ou en-dessous. 
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Insérer une colonne. 

De même que pour la ligne, pour une colonne à insérer, positionnez vous dans une colonnes et avec 
le même menu que ci-dessus, faites insérer une colonne à gauche ou à droite. 

Propriétés du tableau. 

Pour afficher les propriétés du tableau, se mettre dans une cellule et faire : Tableau>Propriétés du 
tableau. 
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Chapitre 5 - Les images 

Insertion d’images dans un document. 

Ce document est truffé d’images. 

 

Les images sont importantes car souvent elles donnent plus d’explications qu’un long texte. 
Et puis si ces images sont des photos personnelles, elles sont irremplaçables … 

Quelles images ? 

Ils existent plusieurs images : 

• des photos, 

• des dessins,  

• des copies d’écran, 

• des graphiques, 

• des organigrammes, 

• des formules mathématiques, 

• … 
 

Images provenant d’un fichier. 

Dans la majeure partie des cas, vous avez des images ou photos et vous souhaitez les insérer dans 
vos textes. 

Pour faire cela, faire le menu : Insertion>Images>A partir d’un fichier ou l’icône . 

Dans la fenêtre de choix de fichier, cherchez votre image ou photo, puis faire OK. 

 
La photo, comme celle ci dessus vient s’insérer dans votre texte. Elle fait partie de votre texte et 
« subit » le même formatage (alignée sur les frontières de paragraphe, …). Cette intégration est la 
valeur implicite.  
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L’image est affichée pour tenir si elle est plus grande que la page, réduite, afin de tenir au plus large 
dans la page. 

 

Si vous souhaitez réduire encore la taille de la photo, utilisez les poignées qui apparaissent au quatre 
coins de l’image lorsque vous cliquez une fois dans l’image. 
 

Pour changer les autres options et organiser l’image autrement, cliquez deux fois dans l’image. Vous 
devez voir cette fenêtre : 

 

Si vous voulez savoir comment nous 
avons fait pour avoir le texte à gauche et 
l’image à droite et bien nous avons 
utilisez le style d’habillage = 
Encadré, 

Et Alignement horizontale = Droite. 

Voici plus bas d’autres exemples en 
utilisant les différentes options. 

 

 

 
 

 

 

 

 

 
 

 

 
Style =Encadré, cadrage = droite. 
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Style = Derrière le texte, cadrage = Droite 

 
Style = Devant le texte, cadrage = Droite. 

 

A tout moment, il est possible de redimensionner, de bouger l’image (en cliquent sur l’image et en 
bougeant avec le bouton gauche de la souris maintenu appuyé. 

Il est même possible de faire pivoter l’image en utilisant la poignée qui apparaît en vert au dessus de 
l’image). 

Image provenant d’un copier coller. 

Il existe de nombreux utilitaires permettant de copier une image dans le presse papier. Pour coller 
cette image dans votre texte, placer votre curseur là où vous voulez l’insérer et faites 
Edition>Coller. 
Vous vous retrouverez dans la même situation que précédemment. 

Image provenant de la bibliothèque. 

Word vous propose des images classées dans une bibliothèque. 

Pour y accéder faites : Insertion>Image>Images clipart. 
Vous aurez alors la fenêtre de droite qui s’ouvrira en vous proposant des séries d’images. 
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Insertion d’un dessin. 

Attention, je ne recommande pas ce mode car depuis 
plusieurs années, chaque changement de version de 
Word éprouve des difficultés à reprendre les dessins 

effectués dans une version antérieure. 
Je recommande plutôt de faire votre dessin dans un 
logiciel spécialisé et ensuite de faire un copier coller. 

 

Pour insérer un dessin, faites : Insérer>Image>Nouveau dessin ou  

Vous disposez alors à l’intérieur d’un cadre des outils de dessins qui figurent en bas de votre fenêtre. 

 
Si vous souhaitez sortir du cadre pour dessiner par exemple une flèche qui va d’un point de texte à un 
autre, faites la touche Echappement ou Esc. Et faites votre flèche comme celle-ci. 
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CHAPITRE 6 - Structuration du document 

Pourquoi une structure ? 

Si vous faites une simple lettre, il n’y a pas besoin de structurer ce document réduit à une ou deux 
pages. 

Par contre dès que vous vous lancer dans des document plus long (comme cette formation), la 
structuration permet à votre lecteur de mieux naviguer à l’intérieur de celui-ci. Pour ce faire, Word 
vous propose des éléments pour créer cette structuration. 

Les Entêtes et pied de pages. 

Pour qu’un document est une cohérence, il est souvent utile de faire figurer à tout le moins, la date de 
création du document et la numération des pages. Ceci permettra à votre lecteur s’il imprime celui-ci, 
au moins de pouvoir classer ses pages. 

On pourra également faire figurer un logo, le nom de l’auteur, etc. .. 

C’est éléments, sous Word, vont figurer dans l’entête et ou le pied de page. 

Qu’est-ce que l’entête et le 
pied de page. 

Ce sont les deux zones qui apparaissent lorsque 
vous faites le menu : Affichage>Entête et pied 
de page. 

Lorsque vous êtes dans cette configuration, vous 
pouvez y faire figurer tout ce vous voulez (des 
images, des textes, des variables, etc.) 

 

Word distingue l’entête de première page de celui 
des pages suivantes (idem pour le pied de page). 
Ceci permet, pour la page de garde de mettre une 
page d’entête spécifique. 

De même vous pouvez, si vous faites un livre avec 
des pages en vis-à-vis, demander une entête 
différente entre la page de numérotation paire et 
celle impaire. 

Ces éléments se règle par le menu :  

Fichier>Mise en page. 

Ou par :  

 

 
 

 

 

 

 

 
 

 

 

 

La mise en page permet de nombreuses autres choses. 

Pour le moment, concentrons nous sur ce qui est relatif aux entêtes.  
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Les deux cases à cocher peuvent l’être. 
Dans ce cas l’intitulé de l’entête 
changera pour vous guider. 

 
Et 

 
 
 

 

 

 

Les variables de champ. 

Une variable de champ est une variable qui sera calculée au moment de l’enregistrement ou de 
l’impression du document. 

Les principales variables concernent : 

• Les dates, 

• Les heures, 

• Les pages, 

• Les fichiers 

• … 

Insérer les variables. 
Les principales variables sont accessibles directement sur la barre d’entête : 

 
Rappelez-vous que pour positionner vos variables, vous disposez en standard d’un tabulation centrée 
au centre d’une entête ou d’un pied de page, et d’un tabulation de cadrage droite sur la marge de 
droite. 

Sachez également qu’il n’est pas interdit de modifier les marges de gauche et de droite ainsi que le 
nombre de lignes possibles pour les entêtes et pied de page. 
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Où trouver les variables de champ? 

Soit dans la barre Entête et pied de page, soit par le menu : Insertion>Champ… 

 
Vous voyez qu’il existe de nombreuses catégories de variables. Nous n’analyserons qu’une toute petite 
partie de celles-ci. A vous d’aller voir ce qui se cache dans les autres : 

1. Date et heure 
a. CreateDate (insère la date de création du document, c’est-à-dire au moment du 

premier enregistrement), 

b. Date (Insère la date du jour) 

c. EditTime (Le temps total passé à l’édition du document) 

d. Heure (L’heure actuelle) , 
e. PrintDate (Date de la dernière impression) 

f. SaveDate (Date de dernière sauvegarde). 

2. Numérotation 

a. Page (insère le numéro de la page en cours) 

3. Résumé 

a. NumPage (Nombre total de pages) 
b. FileName (Nom du fichier et éventuellement le chemin du fichier) 

4. Table et Index 

a. Sommaire (Insère un sommaire) 

 

Vous devez comprendre que Word va remplacer la variable de champ par la valeur trouvée ou 
calculée. Ainsi le nombre de page de votre document évolue constamment au fur et à mesure que 
vous créez des pages. 

Le sommaire. 

Le sommaire correspond à la deuxième page de ce document. 

Un sommaire répertorie tous les titres que vous avez créer dans votre document et précise le numéro 
de la page dans laquelle le titre est présent. De plus, il est possible d’aller directement à cette page en 
faisant CTRL+Click sur le numéro de page (Astucieux Hein !). 

Un sommaire se trouve généralement en page 2 d’un document. 
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Création d’un sommaire. 

D’abord créer un texte « Sommaire » pour que votre lecteur le devine. Ensuite sur la ligne suivante 
faite : Insertion>Champ>Table et Index>Sommaire. 

 
A la suite de votre saisie, le sommaire sera rempli par les titres déjà présents. 
 

Au cours de votre saisie, vous allez ajouter des pages et des titres supplémentaires. Votre table de 
sommaire ne sera pas mise à jour au fur et à mesure. 

Si vous souhaitez mettre à jour votre table, il faut le faire explicitement. 

Mise à jour du sommaire. 

(Cette action est valable pour tous les types de champ). 

1. Allez sur votre sommaire,  

2. cliquez n’importe où à l’intérieur du sommaire. Un fond gris doit apparaître sur tout le 
sommaire). 

3. Cliquez avec le bouton droit de la 
souris. Un menu contextuel 
apparaît. 

4. Choisir dans le menu : Mettre à 
jour les champs. 

5. Une fenêtre doit apparaître : 
 
 
 
 
 

6. C 

7. Choisir Mettre à jour toute la table. 

 

Une autre méthode consiste à demander à Word de mettre à jour les champs au moment de 
l’impression. 

Menu : Outils>Options 
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Les sections. 

Les sections sont utilisées pour de très gros documents qu’il faut structurer plus finement, mais 
également lorsque votre document comporte une rupture de formatage. Par exemple, votre document 
est formaté en A4 vertical (comme ce document) et à un moment de votre document, une ou 
plusieurs pages en A4 horizontal doivent être insérées. 

Pour traiter ce cas, il vous faudra donc introduire un saut de section. 

Un saut, car il faut sauter à une nouvelle page, et de section car on va fermer la section en cours et 
créer une nouvelle section. 

A cette nouvelle section, vous allez donner un nouveau formatage. 

Voyez la page suivant qui n’est qu’un exemple : 
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Format 
paysage 

Formatage paysage appliqué à la 
page 
(Menu : Fichier>Mise en page  

(1) 

(2) 
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Pour revenir à un format A4 vertical, il suffit de refaire un saut de section avec saut de page, puis 
d’appliquer avec le menu Fichier>Format page le format A4 vertical. 

Après cette action, vous êtes en section 3. 

La section 1 est constituée par le début du document, 

La section 2 est constituée par la page en A4 horizontal, 

La section 3 continue le document. 
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Conclusion provisoire 

Nous sommes arrivés à la fin de la première partie de cette formation. 

Avec ce que vous savez, vous devez vous débrouiller sur tout type de document. 
 

Pour finaliser votre formation, je vous propose une suite à cette formation. Celle-ci vous permettra 
d’aborder : 

• Les modèles qui permettent de mémoriser tous vos paramètres d’un document à un 
autre vous évitant ainsi beaucoup de travail, 

• La fusion de document qui permet de faire des listes de mailing, 

• Les options de Word pour paramétrer votre environnement de travail. 
 

Félicitation quand même si vous êtes arrivés à la fin de 
ce document. 

Vous êtes maintenant un spécialiste. 

Demain vous serez un expert ….  


